If you want control ... you need the right connections

“ErgoTorq”.

Patented products,specifically designed to provide solutions to
pulse and nutrunner assembly tooling Safety, Ergonomic, Quality,

Reliability and Cost Down problems.
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Superior selection, performance and delivery, at reduced cost !




“ErgoTorq”
“Guided” Pulse Tool Extensions

(U.S. Patent #6,321,855)

"Standard Weight" Pulse Tool Extensions

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s
(*IFufi models with exposed anvil behingd square drive of > 385"

3/8" Square Drive 1/2" Square Drive
Length Part# Net Price Length Part# Net Price
4" | AREX3-4(1) | $49.89 4" AREX4-4(3) | $52.39
6" | AREX3-6(1) | $54.55 6" AREX4-6(3) | $57.44
8" | AREX3-8(1) | $57.75 8" AREX4-8(3) | $62.82
10" | AREX3-10(1) | $67.58 10" | AREX4-10(3) | $76.47
12 L ARES-1a0l) L $77.03 12" | AREX4-12(3) | $85.36
Superior selection,
Atlas Copco Pulse Tool Part #'s performance and
delivery then any
3/8" Square Drive 1/2" Square Drive competitors product
Length Part# Net Price | | Length Part# i Sdgi«-%” atreducedcost!
.l AREX3-4(2) $49.89 4" AREX4-4(5) | $52.39
6" | AREX3-6(2) | $54.55 6" AREX4-6(5) | $57.44
8" | AREX3-8(2) | $57.75 8" | AREX4-8(5) | $62.82
10| AREXS-I0(2) 1 P07.58 10" | AREX4-10(5) | $76.47
12 ] AREX3-122) | $77.03 12" | AREX4-12(5) | $85.36

“Utralite" Pulse Tool Extensions ... up w 50% lighter then standard extensions

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s
(*)Fuji models with exposed anvil behind sguare drive of > 385"

3/8" Square Drive 1/2" Square Drive Durability tested to
Length Part# Net Price Length Part# Net Price
4" ARUEX3-4(1) $59.89 4" ARUEX4-4(3) | $62.39 100'000 CYCIES !

6" ARUEX3-6(1) | $64.55 6" ARUEX4-6(3) | $67.44
8" ARUEX3-8(1) | $67.75 8" | ARUEX4-8(3) | $72.82
10" | ARUEX3-10(1) | $77.58 10" | ARUEX4-10(3)| $85.47
12" | ARUEX3-12(1) | $87.03 12" | ARUEX4-12(3)| $95.36

Atlas Copco Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive C
Length Part# Net Price | |_Length Part# | Net Price WL
4" | ARUEX3-4(2) | $59.89 4" | ARUEX4-4(5) | $62.39 '
6" | ARUEX3-6(2) | $64.55 6" | ARUEX4-6(5) | $67.44
8" | ARUEX3-8(2) | $67.75 8" | ARUEX4-8(5) | $72.82
10" | ARUEX3-10(2) | $77.58 10" | ARUEX4-10(5) | $85.47
12" | ARUEX3-12(2) | $87.03 12" | ARUEX4-12(5) | $95.36

* "imalite" extensions are available in virtually any length and drive end configuration.

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorg.com)



“ErgoTorq”
“Guided” Sockets & Accessories For Tool To Socket Applications

(U.S. Patent #6,321,855)
A low cost, high quality alternative to our competitors pulse tool accessories !!!

Pulse Tool 6 Point Standard Length Sockets

Designed to Fit Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tools
3/8" Square Drive Standard  3/8" Square Drive Metric  1/2" Square Drive Standard 1/2" Square Drive Metric

Fastener Fastener Fastener Fastener MNet
Size Part# Met Price Size Part# Met Price |  Size Part# | Net Price || Size Part# Price
3/8" AR3112(1) | $38.19 10mm  |AR10mm13(1}| %$38.19 1/2" | AR5116(3) | $39.56 12mm | AR12mm15(3) | $39.56
7i16" AR3114{1) | $38.19 llmm |ARLImm13(1)| $38.19 9/16" | ARS118(3) | $39.56 l4mm | AR14mm15(3) | $39.56
12" AR3Z116(1) | $38.75 12mm  |AR1Zmm13(1)| $3B.75 5/8" | AR5120(3) | $41.29 16mm | AR16mmM15(3) | $41.29
9/16" AR3118(1) | $40.22 13mm__ |AR13mmi13(1)| $40.22 | 11/16" | ARS122(3) | $42.73 || 18mm |ARI8Bmm15(3) | $42.73
5/8" AR3120(1) | $40.79 14mm  |AR14mm13(1)| $40.79 3/4" | ARS5124(3) | $43.55 19mm | ARISmm15(3) | $43.55
11/16" AR3122(1) | %$41.89 15mm  |ARISmm13(1)| $41.89 | 13/16" | AR5126(3) | $45.47 || 20mm |AR20mm1S(3)| $45.47
34" AR3124(1) | $42.23 16mm | ARIEmm13(1)| $42.23 7/8" | ARS5128(3) | $45.04 || 22mm |ARZImm15(3) | $45.04
13/16" AR3126(1) | $42.91 17mm  |ARIZmm13{1)| $42,91 | 15/16" | ARS130(3) | $45.04 24mm AR24rﬂrn15lE3} $45.04

1" AR5132(3) | $46.35 25mm_ [ AR25mm15(3) | $46.35

Designed to Fit Atlas Copco Pulse Tool’s
‘3/8" Square Drive Standard  3/8" Square Drive Metric

Fastener Fastener Virtually any : A :
Size Part# Met Price Size Part# Net Price accessory is 0 ( gded
3/8" AR3112(2) %$38.19 10mm_ [AR1Omm13{2) | %$38.19 available for all dantn
/16" | AR3LI4(2) | $38.19 i Itmm [ARLimmi(Z)) $38.19 } o cortyrers
1/2" | AR3116(2) | $38.75 12mm__ | AR12mm13(2) | $38.75 | s 1 e - -
516 | ARaLIE() | $40.22 13mm__|ARI3mm13(2) | $40.22 pulse tools ! sulse tool quided
5/8" | AR3120(2) | $40.79 M| ARIAmvn13(2) | 340,79 ....“‘"‘ﬁ E :

11/16" AR3122(2) $41.89 15mm  [AR1Smm13{2) | $41.89 - 2
34 AR3124(0) | $42.23 i6mm | ARI6GMmM13(2)| $42.23
13/16" AR3126(2) $42.91 17mm_ [ARI7mmi13(2)| %$42.91

1/2" Square Drive Standard  1/2" Square Drive Metric 1/2" Square Drive Standard 1/2" Square Drive Metric

Models - 12X, 14X, 14XS, 10PT/PTS,  Models - 12X, 14X, 14XS, 10PT/PTS, Models - 10C, 10XS, 12XS Models - 10C, 10XS, 12X5
12PT/PTS 12PT/PTS
Fastener Fastenar MNet Fastener Fastenar MNet
Size Parts# Met Price Size Part# Price Size Part# Met Price Size Part# Price
172" AR5116(5) | $39.56 12mm | AR12mm15(5) | $39.56 1/2" | ARS116(5a)| %39.56 12mm | AR12mm15(5a}| $39.56
9/16" | AR5118(5) | $39.56 14mm | AR14mm15(5) | $39.56 9/16" | ARS118(5a)| %$39.56 14mm | AR14mmi5(5a) | $39.56
5/8" | AR5120(S) | $41.29 16mm | AR16mm15(5) | $41.29 5/8" |AR5120(Sa)| $41.29 | f 16mm IARIémm13(3a)| $41.29
11/16" | AR5122(5) | $42.73 18mm | AR18mm15(5) | $42.73 11/16" | AR5122(53) | $42.73 18mm | AR18mm15(5a)| $42.73
3/4" | AR5124(5) | $43.55 19mm | AR19mm15(5) | $43.55 34" | AR5124(5a) | $43.55 19mm | AR19mm15(5a)| $43.55
13/16"_| AR5126(5) | $45.47 20mm_| AR20mm15(5) | $45.47 13/16" | AR5126(5a) | $45.47 | j—20mm ARZ0mm13(3a) | $45.47
7/8" | AR5128(5) | $45.04 22mm_| AR22mm15(5) | $45.04 7/8" | ARS128(5a)| $45.04 | |22mm |ARZZmmIN(3a) ] $45.04
15/16" | AR5130(5) | $45.04 24mm_| AR24mm155) | $45.04 15/16" | AR5130(5a)| $45.04 | |—23mm |AR24mm15(5a)| $45.04
1" AR5132(5) | $46.35 25mm | AR25mm15(5) | $46.35 1" | AR5132({5a)| $46.35 Zimm_| ARZSmm15(5a) | $46.35
Pulse Tool Quick Change Adapters
Uryu / Aimco Pulse Tool Part #'s Atlas Copco Pulse Tool Part #'s
(*)Fuji models with exposed anvil behind square drive of > 385"
3/8" Square Drive 1/2" Square Drive 3/8" Square Drive 1/2" Square Drive
Hex MNet Hex Net Hex MNet Hex MNet
Crive Part# Price Drive Part# Price Drive Part# Price Drive Part# Price
1/4" | ARQR-308(1)| $78.52 || 1/4" | ARQR-508(4) | $78.52 || 1/4" | ARQR-308(2) | $78.52 1/4" | ARQR-508(5) or (Sa)| $76.52
7/16" | AROR-314(1)| $98.88 | | 7/16" | AROR-514(4) | $98.88 | 7/16" | ARQR-314(2) | $98.88 2/16_IARQR-514(5) or (Sa)| $96.88
5/8" | ARQR-520(4) |$105.90 5/8" | ARQR-520(5) or (5a)| $105.90

* Virtually any standard 3/8", 1/2" & 3/4" drive attachment is available in pulse tool format.

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorg.com.)



“ErgoTorq”

“Guided” Sockets & Accessories For Extension To Socket Applications

(U.5. Patent #6,321,855)

A low cost, high quality alternative to competitive pulse tool accessories !!!

Guided, 6 Point, Standard Length, Non-magnetic Sockets

Min. Order of 5 pcs./Part#

Designed To Fit “ErgoTorq” Pulse Tool Extensions

3/8" Square Drive Standard 3/8" Square Drive Metric
Fastener Fastener
Size Part# Net Price Size Part# Net Price
3/8" AR3112(1) | $38.19 10mm |AR10mm13(1)| $38.19
7/16" AR3114(1) $38.19 1lmm |AR11mmi13(1)| $38.19
1/2" AR3116(1) | $38.75 12mm |AR12mm13(1)| $38.75
9/16" AR3118(1) | $40.22 13mm |AR13mmi13(1)| $40.22
5/8" AR3120(1) | $40.79 14mm |AR14mmi13(1)| $40.79
11/16" AR3122(1) $41.89 15mm |AR15mm13(1)| $41.89
3/4" AR3124(1) | $42.23 16mm |AR16mm13(1)| $42.23
13/16" AR3126(1) $42.91 17mm |AR17mm13(1)| $42.91
1/2" Square Drive Standard 1/2" Square Drive Metric
Fastener Fastener Net
Size Part# Net Price Size Part# Price
1/2" | AR5116(3) | $39.56 12mm |AR12mm15(3) | $39.56
9/16" | AR5118(3) | $39.56 149mm | AR14mm15(3) | $39.56
5/8" AR5120(3) | $41.29 16mm |AR16mm15(3) | $41.29
11/16" | AR5122(3) | $42.73 18mm | AR18mm15(3) | $42.73
3/4" AR5124(3) | $43.55 19mm | AR19mm15(3) | $43.55
13/16" | AR5126(3) | $45.47 20mm |AR20mm15(3) | $45.47
7/8" AR5128(3) | $45.04 22mm | AR22mm15(3) | $45.04
15/16" | AR5130(3) | $45.04 24mm | AR24mm15(3) | $45.04
1" AR5132(3) | $46.35 25mm | AR25mm15(3) | $46.35

* Virtually any standard 3/8", 1/2" & 3/4" drive attachment is available in pulse tool format.

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorg.com.)



ErgoTorq "Socket Adaptors”

for Uryu Pulse Tools > Asgex Accessories

(U.S. Patent #6,321,8
“Adaptors” for Uryu Pulse Tools > Apex Sockets

| ] 70 HORE0E) ARDEA)
| 136 81T ARDTAT)
I_ T ETE) ARDEA1)
% Souae Drive > | 1SHE 53 = ARDSA)
| 1'% 000y ARI0A)
For Atlas Copco | 14N67(1 065') ARV0AZ(1)
pulse tools | 1113 (ORI} ARDAN(1)
* | 111257 ART1IA)
simply change : . e i
the (1) toa (2) or | | 0.925" (CRS08) ARZ2A(3)
the (3} toa [5} I 1SHE 53 ARAIALY
| 17{1.0007) ARTAA)
! 1AHE™1.063") ARIAAZ(T)
| 1113 [QR514) ARIAA(3)
| 1811257 ARTBALY)
| 1-1M47(1.2507) ARIBALY)
| 151671 312" ARTBAI(T)
! 1-3F(1.375] ARITAT)
| 1-AR2(1,5007) ARIBAIY
| 1581625 ARTEAT)
112" Scpane Drive = | 1-34"1.750") = ARONT) $36. SOIea
| 1T 1875 ARZIAT)
| 1-15M6 1 23 AN =

| 220007) ARZIALY) Min. Order of
| AW 125 ARZANT)

| A2 250 ARZENY 5 pr.s.fParI:#
| 2382378 ARZEALY)
I ZAREE ST ARZTAY

“Adaptors” for Apex Extensions > Apex Sockets

Apex Extension Series * Socket - Drive End 0.D. "ErgoTorg" Part #'s |
1R2°( 5007 AR3IA
8ME"[ 5637) AR3AA
SI"( 6257 ARISA |
11M6"( BETE") ARJEAN
EX-250 » M TS0 . ARIBA “Erg{lTﬂ rq“
1 v wrdumea 13167 8137 ARITA .,
T ATE) AR3EA Adaptﬂrs
SAT(a2s) Anmis easily convert
M TEO%) ARIBA -
TS AR any socket into
. TATLA7T) ARAIA an ergo guided
EX-376 » 5HE™] 5387 = ARAZA
171000 ARAA pulse tool
1-AHE=(1.063°) AR4IAT
111257 ARL4A | attachment.

1-148"(1.2507) AR45A
VRME™] 5387] ARG

1710007 ARATA

A-1HE™{1.08F°) ARATAY

114871, 1257 ARLEA

11471 2507) AR4L9A

1816513127 AR49A1

1-28"[1.3757) ARS0A

102715007 ARS1A

188" 1 6257) ARSI

EX-506 > 1-34"[1.7507) = ARSIA
e ) 1-T8"[1.8757) ARS4A
118181 9357 ARSEA

I 00 ARSEA

2-1/" | ARSTA

2-114" I ARSEA

2-387 (2. 3TET] ARG

222 5007) ARG0A

*PLEASE NOTE : To determine socket drive end 0.D., check "C" dimensions in Apex catalogue.

* Virtually any standard 3/8", 1/2" & 3/4" drive attachment is available in pulse tool format.

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorg.com.)



Nutrunner Guided Extensions, &

Atlas Copco Nutrunner Guide Extension “Collar” Part #'s

“ErgoTorq”

"“PinchPoint Protectors”
{U.5. Patent #6,123,157)

‘Anglehead Tools Inline Tools “Collar's”
AC Front Nut #or| "Collar” A.C. Renxction Bar "Collar” o e fitted
Square Drive | Thread O.D.'s Part #'s | Scuare Drive Nut Part# Part #'s an be fitted to
EL) 4210 1877 00 ARZO0-A1 E'j:5 20213500 | AR00-S1 virtually any
e 4210 3349 00 ARZ00-A2 E'l-3 4210 2135 00 e — manufacturers
38" 4210334001 | ARZ00-A2(01) 2 L8 20 BLD D e nutrunner tool !
I8 4210334902 | ARR00-A2(02) k'L 4210 1799 00 _AR200-54
. >
yz 4210334508 | ARZ00-A2(D3) ﬁz' L SN
¥ 4210334505 | AR200-A2(05) e 4210 2218 00 AR ST Vipotemtrtont
¥ 210249200 | araoo-ss e s
2 4210 1140 00 ARZ00-AB PlStO[ GI"II! Tools e
' | “Renction Bar Nut” | "Collar"
I 4210 1141 00 AFZ00-AT | Sumne Drive | Part# Part #'s
-k Dot Lithe ARZ00-A9 | e | wowsm | ARID0-P2
- St Vel ARI00:30 | 4210-213500 AR00-P3
YE_MeaAXOTSLHivead ARZ00A10ET | Peveloping Collar & Extension Part # \  giiminate extensi
2 4220 1992 00 ARZ00-A11 iminate extension ~ J§
- ; 1 To determine your “Collar” & Extension Part #, simply\y wobble, improve tool J
L N9 X 1.0 LHthvead | AR00-A11ET add required extension information in ( )'s after the N, torque quality & #
e 4210 3860 00 ARZ00-A12 “ErgoTorq” "Collar” Part+#, using a 3 for 3/8" drive or 4 for ™%, rellahlllhr 1
4" 4210 4065 00 ARZ00-A13 12" drive and the length of extension.
Example : Part#- AR200-A1(3-8) for a "Collar” and 3/8" X 8" extension.
ya 4110 1407 00 ARZ00-A14 For an Ffvalite extension insert a U in front of the the drive size number. eg.(L3-8)
AW 4220174206 | ARR00-A15 |
¥ | 4210449500 | ARR00-A16 OSHA
38 MET X 0.75 LHthread| ARZOO-A17ET Atlas Copco Nutrunner Approved
g - =
¥ | 4810 3260 00 ARZO0-A18 “PinchPoint Protector” Part #'s e :
e M3 X 1 LHthread | ARZO0-A19ET Inline Tool esign :
niine 100Is
MKE X 1 LHthread
AFZODAZ0ET Sqare |AC Reaction Bar "PinchPoint Probector”
Amlﬂlaad:rools | Dive | epa Part #5
AC. Front Nut | "PinchPoint Protector” :
sy Pt 2 H. | azo213s00 | PP200-51
= B.PB‘_ ey —— i) 4710 2135 00 PP200-51 T tecepiy
! PP200-A1 : S PP200-S3
38 | 4220199400 PP200-A10 * 33_ ! 453 g’:ﬁ 1 s
3B | 421033000 PP200-A2 e ! PP200-54
1 : 1 Nz 4210 2218 00 PP200-52
e 4210 3349 01 PP200-A2(01) o -
38 210 339 2 PP200-A2(02) -4 S 4210221800 | PP200-5TMuscprs 275.00 Net/ea
3 | owxaoo | P —— i 4210 2135 00 PP200-55 . Eliminates the inherent
T I | A " | pinchpoint that exists
v | 42301992 00 | PP200-A11 * | AC. Reaction Bar| "PinchPoint Protector” he_twgen the tool and its’
2T | 2033980 | PP200-A2(03) | SqereDrive| Nt Part# | Part # N attachment!
14'2" | 4210114000 | PPJ:_U.'I-M | | aooiwso | PP:mm_l
4210 1141 00 LS 4210:2135-00
ﬁmmr'ﬂmmlwﬁﬂ . simply add a [/ and the three decimal place 0.D. of the socket
being used, and an (S) for "Standard” Example : PP200-A1/.750(S) -
"Uttalite" a i ions el
Standard Square Drive Extensions
Durability tested to "%

pcs./Part#
Up to 50% lighter then normal extensions !

100,000 cycles !

3/8" Square Drive 1/2" Square Drive
Length Part# Net Pricing Length Part# Net Pricing
4" AUEX3-4 $58.72 4 ARUEX4-4 $56.72
6" ARUEX3-6 $65.40 6" ARUEX4-6 $71.87
g ARUEX3-8 $72.93 B“, AREXSS 37820 Available in virtually any
10" ARUEX3-10 $91.15 10° ARUEX4-10 $98.15 W, length and drive _#
12" ARUEX3-12 | $96.21 12" ARUEX4-12 $103.78  configuration Ly

For extension lengths longer then 12", simply ask for a quote.



“ErgoTorq”
“Non-Rotating” & “Slip Type”
Tooling Attachment Covers

NEW!
“Non-Rotating”
tooling attachment
covers provide

. Nnn-rata trng/Retractabfe

1/2a">1/2" dr. sockets & extension up to 12"

Covered Bit Holders o _ .
« eliminate the potential of “Product Mutilation” * eliminate the “"Rotating Shaft Safety
defects caused by rotating tooling attachments Hazard” which can cause serious injuries to
coming into contact with finished surfaces operators who are continually exposed to
« are available in guided format for pulse tool * can be designed for use with various fastener
applications or standard drive format for sizes as well as our ~2ltalite” extensions to
nutrunner type tools meet the specific needs of the customer

Ask your local ErgoTorq Distributor for a quote or contact us directly !
“Dual Drive” Sockets

LN

* “"Dual-drive” sockets
are available in virtually
any drive size and type
configurations.

(Simply ask your ErgoTorq
Authorized Distributor for a quote.)

“NEW” e ~$395.00
Dual-drive sockets Net/ea
will significantly

reduce process
cycle times !

» Patent Pending design allows tooling operators « can be designed for use on a wide range of
to rundown two different size fasteners with the various fastener sizes to meet the needs of the
same socket without having to handle the socket  customer

« available in guided format for pulse tool « significant cycle time reductions can be
applications or standard drive format for achieved with this "NEW" innovative product !!!

nutrunner tools

For ordering or product information, contact your local ErgoTorq distributor, call

Ergonomics Specialties at (519) 425-2604, visit our web-site at www.ergotorg.com
and submit an Order or a Quote request or e-mail us at ergotorq@execulink.com
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